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Forewords

When I started imview, I had no idea it would take me so long to get where I wanted, that
it would be so big, or that I would write a 100+ pages document about it.

So you’re staring at a monster. I've intended this documentation primarily for my colleagues
and as a reference document, not as bedtime reading.

Normally, imview should be somewhat intuitive, but has a few quirks. Hopefully I've docu-
mented all of them. When you encounter something strange, look in this document and you
should see a few words about it. If not contact me.

Thansk for your interest in imview.
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Chapter 1

What is new?

This chapter allows bleeding-edge users to get the last word on what is happening. Assuming

anyone is interested, of course.

See appendix [D] for a detailed history of changes and more recently to the ChangeLog file in
the source distribution.

e This documentation now refers to version 1.0.1 of imview and anticipate in places fea-
tures present in 1.1.x (these are clearly marked). This version is pretty much 0.9.x with
a number of bugs removed. In addition there is a new colour brightness-contrast-gamma
panel to supplement the grey-level one. Imview 1.0.x is based on FLTK-1.0.x, future
releases will be based on FLTK-1.1.x.

e version 0.9.x introduced image rotations (2D and 3D) and mirroring, improved pointfile
handling (much faster), image overlays including transparency, text annotation (coupled
with points), a primitive toolbar, the possibility to hide the main menu, saving of the
raw image data, a ‘stretch-to-fit’ mode where resizing the main window also resizes the
image within it, improved dialog resizing, POSIX IPC (on Solaris and Compaq Tru64
only), a TCP client so that several imviews can be linked now, and lots of bugs fixes

and minor enhancements.

e Since the last beta (0.2.x) a lot has changed. Imview can now behave as an ‘image
server’. This has yet to be fully documented, but is already used heavily in Voir, our
group’s new image analysis environment. Have a look at chapter [5| for the current state
of the documentation on this issue.

e Imview now links with ImageMagick, which gives it access to a lot of image format (read
and write). It also comes with a suite of new hassles.

e a lot of Windows-specific quirks have been eliminated. It even works on multi-cpu
machines, with the server stuff and all. Quite an achivement I thought...

15
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Chapter 1. What is new?

This document now has a windows-specific section in Appendix [A]

Imview now has a interactive bivariate histogram window. Useful for colour or multi-

spectral image segmentation.
Imview can now rotate (in 90°increments) and flip images.

Imview supports the -gamma <value> command line argument to setup a default

gamma for all images.

Imview can print a list of images on one page, just like the laser function of Z-IMAGE.
There is a preview option on the print panel (Ghostview or some postscript previewer
must be installed however).

Imview now works fine with SZ.

Imview now interfaces with Ghostscript to display PS files (any file, not just images).
Rendering options are user-configurable (resolution, etc).

Imview now saves and reads user-configurable options.

Imview now runs on Windows NT and Windows’95! Tested on NT3.51, NT4.0 and at
home on ’95. It seems to work best in NT3.51 for some reason.

Imview can show 1-D arbitrary profiles of 2-D images. These profiles can be saved and
printed.

Zoom regions of interest (ROI) can now be defined with arbitrary aspect ratios.

Imview has some hyperspectral images support: spectra can be displayed interactively,
and can be saved or printed.

Imview now has contrast, brightness and gamma control. It is now a complete replace-
ment for x11(). You can use these controls for interactive thresholding!

Imview can now save images to a file (in TIFF or Z-IMAGE formats only at present,
Postscript is also supported under a different mechanism (printing)).

Imview can now print or save images in Postscript format.

Imview now supports multi-frame (or multi-page) documents, such as TIFF stacks,
animated GIF, and non-multispectral, multi-component Z-IMAGE files.

Imview now has a help menu. It points both to a quick online help and this present
document in HTML format (it automatically launches netscape to read it).

Imview now supports pointfiles in a complete way. ‘breaks’ (or point grouping) support
is now working and is much more useable than under x11(): for a start the groupings
are now visible (points in the same group are linked by line overlays).
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Imview now reads the ICS format for grey-level images (char, short and floats).

Imview redraws images and overlays (such as information box and zoom boxes) much
faster than before.

Imview now supports 3-D images in the same way that x11() and scilimage do: users
can flip to and fro through 2-D sections of the Z plane.

Updated feature list, TODO list and bug list.

Possibly interesting CPU and memory benchmark section (see section .
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Chapter 2

A (long) introduction to imview

People not interested in self-justificating rambling and other dubious philosophical questions
on application development, but want to know how to use the damn software can jump
straight to chapter

On the other hand, those who want to know a bit more about imview, where it comes from
and where it is headed can read on at their own risk.

Be aware that some comments may be rather cryptic if you are not one of my immediate
colleague, in particular all the business about x11 (), which is basically the image viewer that

my research group was using before imview.

2.1 What is imview?

imview is a Unix and MS-Windows application originally designed both to replace the x11 ()
function of Z-IMAGE, that is now quite dated, and also to provide a general image viewing
tool.

For users who are not directly my colleagues or who have never worked with Z-IMAGE,
x11() is a basic image display program for Unix/X11 that rely on pseudocolour terminal
functionalities, written using the X toolkit (Xt) and the Athena widget set.

Imview is more modular in design than x11() is, and provides vastly more functionality than
x11 0. It is being built in C++ with a GUI-builder library called £1tk, available at

http://wuw.fltk.org

It is based on a prototype which was developed between 1991 and 1994 in Objective C on
NeXTStep by the same author. It is concurrently being developed on Linux, DEC Unix,
Solaris and Windows NT. SGI IRIX will probably enter the development circle one day.

19
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2.2 Why did I start on imview?

In 1994 when I joined the Image Analyis project at CSIRO, the Commonwealth Scientific and
Industrial Research Organization, Sydney, Australia, The de-facto standard image analysis
package for this group was a home-grown solution called Z-IMAGE. It was a Unix-only system
build around a non-traditional shell which somewhat resembled the statistical S package from
Bell Labs. It has nice image arithmetics, advanced functions were run as separate processes
communicating with the shell using files.

At that time 24-bit, full-colour displays were still an expensive rarity. We still had binary X-
terminals (who could only display pure white and pure black. One had to use dithering to get
a vague impression of grey-levels), and most terminals or workstation only used 8-bit colour.
The image display program everybody used was called x11 (), which had been developed for
Z-IMAGE and only supported 8-bit colour.

I had been spoiled during my previous PhD years with the use of a NeXT cube with NeXT-
dimension full colour graphic card, which had a separate 1960 processor and 8MB of memory
just for itself (the cube had 32MB, a lot in those days). After a few hard months I finally
got a lowly PC (a Pentium 75) at home, with a run-of-the-mill S3 video card which could do
1024x768 in 16-bit colour (in truth a bit more), running Linux 1.2.x (Slackware distribution).
At work I also eventually got an Alpha with a very nice 24-bit display. No one was talking
of accelerated 3D except the SGI guys in those days.

Well, the Z-IMAGE x11() function never worked well for me, especially as I work on a
TrueColor display both at work and at home. x11() simply didn’t work at all on my 16-
bit display at home, and worked very poorly on my 24-bit screen at work (colours were
unpredictable, brightness and contrast manipulation didn’t work, colours flashed all the time).

Before I started on imview, on X I was always using xv, which is still today a very good
program even though the last revision was sometime in 1993, but was noticeably slower than
x110), is no longer maintained anymore, and has a few quirks that I find annoying. Most
importantly it doesn’t have colourmap manipulation of the kind that we used in Z-IMAGE,
it doesn’t understand anything other than CHAR images (grey-level or RGB), it doesn’t use
dithering with or without error diffusion except for 8-bit colour, so grey-level images looked
actually quite poor on my screen at home, xv was never a real Z-IMAGE function and so
has poor command line interface with Z-IMAGE (impossible to display an image with a
given colourmap for example) and finally it didn’t work with pointfiles. The upshot is that I
was constantly switching between those programs (except at home where I couldn’t anyway

because x11() didn’t work unless I downgraded my screen quality to 8-bit...).

imview started as a project provide the facilities I most want from both programs, and a lot
more if at all possible.
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2.3 Why not simply improve x11()?

I tried to do that, but although x11() is well-written and efficient, it is designed to work
with X11 pseudo colour displays, i.e: 8-bit displays with colourmap. Making x11 () work on
truecolor displays would have been very onerous and equivalent to starting all over again.

This is what I did with the help of a reasonable GUI-buiding library. Finding a reasonable
library that could work well with images was difficult by the way. I was looking for something
free (GNU licence if possible), with good documentation, source availability, if possible sup-
port, consistent, fast and in C++ or Objective-C (because object-oriented approaches work
really well with GUI development). Fltk is the only one that fitted this bill at the time
of writing. Possibly today I would start with Qt, but I'm not even sure. The FLTK is re-
ally well done, concise and efficient. There are a number of GUI building libraries in the
public domain, but they either don’t work well with images (V), require a non-free library
(wxWindows used to require MOTIF. It now works with the GTK, however), are not very
well documented (countless others including the GTK), don’t work with C++ or Objective-C
(gtk, although this is possibly improving), don’t come with the source (Xforms), or are not
really available yet or too incomplete (GNUstep). I found f1tk by chance after I had started
with Qt, and couldn’t believe my eyes. It even looked good! (as good as anything can be
on X11) and uses a subset of C++ that I could perfectly live with (no templates, exceptions,
friend classes, operator overload, etc) yet provides an object-oriented framework. Fltk is
exceptionally stable, and its author and contributors provides excellent support via a mailing
list and a web site. On top of it, it works with Windows!

It is also amazingly simple to program with. I recommend it to anybody willing to start on
GUI programming. Quite an eye-opener compared to the excesses of more advanced toolkits.

2.4 imview’s aims

The ultimate end of imview is to be able to

e understand a large number of image formats,

e display 2D and 3D images in a reasonable way,

e display multicomponent and multispectral images,

e display INT and DOUBLE (and more pixel types) images transparently,

e display time series of images (as a movie or frame by frame),

e display labelled objects (and their fitted ellipse, or maximum enscribing rectangle, etc),

e apply simple transforms to images (such as apply colourmaps, rotate images, etc),



22 Chapter 2. A (long) introduction to imview

e provide information on 1-D profiles anywhere in the image.

e manipulate image histograms (apply gamma correction, manipulate brightness and con-
trast, provide interactive thresholding, etc),

e work with pointfiles,
e get pixel-wise information (grey-level or multispectral information under the cursor),
e work on most (if not all) X11 screen depths (8-bit, 16-bit, 24-bit, 32-bit),

e provide a reasonable command-line interface at start-up in addition to the GUL Imview
will perform as well under Z-IMAGE as under the normal Unix prompt.

e and more.

Obviously all of this did not happen in one day. I started in 1997, and in 2003 I was amazed
to see that “display labelled objects” is still not implemented.

In general, imview does provide access to image data and some image manipulation facilities
(like zoom and rotations for example) to display image data in a more useful manner than is
currently possible with other available tools. However, the principal aim of imview is not to
provide image manipulation tools for its own sake, as with Photoshop or the GIMP or even

xv. In some sense imview is an image analysis tool.

2.5 What imview can do at present

As of this writing, imview’s version is 1.0.1 which means its first stable release. It is still
incomplete, however, it has survived three Beta programs (including external paying clients!)
so I'm becoming more and more confident about this software now, even though it still has
obvious flaws. The current imview release has the following features:

e Displays Z-IMAGE, TIFF, GIF, ICS, PNM and JPEG images. Can display INT and
DOUBLE Z-IMAGE images with the wrong endianness transparently (ie: a Z-IMAGE
file created on a Sun can be displayed on a DEC, and vice-versa). Images can be read in
from the standard input. Imview interfaces with Ghostview to display postscript files.

e Version compiled with ImageMagick can read about 60 other common image formats,
among them PNG, Sun Raster, etc.

e Displays 2D images with a very good zoom and pan feature.

e Displays 3D images reasonably. The same zoom and pan feature is available but only

one image slice can be viewed at any time (no rendering).
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Displays Grey-level as well as RGB data. Other multispectral images are read in but
only one spectrum can be displayed at a given time. The user can flip back and forth
through the components, of course.

Displays INT and DOUBLE images transparently (and other pixel types such as SHORT
and FLOAT also available in TIFF and ICS images).

Has useful features for hyperspectral images, such as a real time display of the spectrum
at each point.

Arbitrary 1-D profile of 2-D images (or 2-D slices of 3-D images) can be displayed.

Works with multi-page documents (TIFF stacks, animated GIFs and heterogeneous
multi-component Z-IMAGE files).

Works with pointfiles (in a rather complete and fancy way...). Points are clearly visible
and points belonging to a group (separated by ‘breaks’) are linked on-screen by overlaid

lines.

Images can be zoomed, panned and colourmaps can be applied on CHAR, SHORT and
INT data.

Has pixel-wise information available (displays FLOAT, DOUBLE, SHORT and INT

information in their native format).

Works on most screen depths (8-bit to 32-bit). It doesn’t work on monochrome (1-bit)
displays and probably never will, and it is designed to work best on truecolor displays
(15-bit and above).

Images or parts of images can be printed to a device or to a file.
Images or parts of images can be saved in TIFF or Z-IMAGE format.

Imview has brightness/contrast/gamma control. These can be used for interactive
thresholding.

Many options are already available on the command line. Imview does work both as a
Z-IMAGE function and as a Unix command line function.

Imview is portable: it works the same under Windows (win32).

Imview usually runs as fast or nearly as fast as x11(), much faster than xv, and uses
significantly less memory than either. AFAIK nobody cares about x11() anymore, even
my most conservative co-workers. Other viewers have sprouted thanks to the wonderful
KDE and Gnome efforts, but still none really compares to the old xv in my opinion.
For what I do imview is better than xv but not for everything. (for example xv can

grab windows, put images in the root window, and does offer some basic filtering).
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Most of the work so far has been spent in providing the code infrastructure to make this
possible. Most of the work is actually invisible (no visible user controls correspond to them).
Just putting an image on the screen is not so easy under X11, even with the help of fitk.

2.6 What imview cannot do at present

Of course, many features are missing from an ideal point of view, but my primary goal was
to write a complete replacement for x11() that would also work on non-8-bit, true-colour
displays. I feel that I've achieved this goal since about version 0.9.0, and that imview is
indeed a complete replacement for x11 (), except possibly on pure 8-bit screens. As far as 1
know no one uses those anymore for anything serious.

There is a wish-list of the features I personally want put into imview in section [6], I'm wel-
coming feedback on this issue and the rest as well, of course.
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Tutorial

This chapter is a quick tutorial to imview.

3.1 Starting up

Currently, the images used in this tutorial are located in
/home/talbot/projects/GUI

Change directory to there or copy the images somewhere else and follow the directions.

3.2 Basic GUI

3.2.1 Menu basics

Type

% imview

This is the splash screen. Try selecting the File menu with the mouse. Then click anywhere
on the main window to make the submenu go away. Try selecting an item with the mouse,
for example Open in the File submenu (we will note this item File->Open from now on).

Click on Cancel to dismiss the dialog.

Now try holding down the Alt key while pressing the f key. In the future we we note this
and call this a shortcut. Try navigating the menu with the arrow keys. Notice as the
selection skips over non-available items. Notice also that most items have a shortcut attached
to them (alt+something most of the time). The main submenu have a letter underlined (for

25
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example File has an underlined F). This indicates that this letter is a shortcut available with
the alt key. Indeed is a shortcut to access the File submenu.

Now select one of the available items by typing return. For example let us try , then
arrow key down, then return. You should see the About Imview dialog. Type Esc once to
quit the dialog.

Now try , then arrow key down, then return. This is the Open Image dialog. Type
Esc to close the dialog. Now try . This does the same thing: This is a menu item
shortcut. It allows the user to select the item in a minimal number of key strokes.

3.2.2 Loading an image

Type , or open the Open Image dialog any way you like. It this dialog, the button on
the left hand side navigate the directory hierarchy. Try going up and down directories. The
underlined letters in the left hand side buttons also indicate shortcuts, just like in the main

menu. Try them.

To go up a directory, press the Up one directory button. To go down one directory, select
any directory available from the right hand side list. Do not double-click on them.
Directories end with a /. Normal files do not. To go back to the directory where you started

imview in, press the Current dir button.

To view only the directories, press the */Directories button. Click on * to see the normal
files again. To see all the files, including the normally hidden one (under Unix, those starting
with . and a few others), press the * A1l files button.

To go to your home directory, click on /Home. To go to the Root of the current disk, click
on / Root.

Try selecting a normal file (click on an item on the right-hand side list that do not end in
/). This file name appears on the input field at the bottom of the dialog. Try navigating the
list of files and directories with the up and down arrow. See what happens when you select
a directory this way and press the Enter key.

Now click in the input area at the bottom of the dialog. Try typing a full path to a known
image, for example /home/talbot/projects/GUI/ibr001_z. What happens when you type
after each keypress? After having typed /home/tal, try pressing the Tab key. Notice that
the directory name is completed for you. This allows the user to type in full paths quickly.

If you know Emacs, try typing the line editing command keys, such as ,
|Control+e|, [Control+f] [Control+b| etc. Try selecting a section of the path with the

mouse, and then erase it with Backspace.

Now try selecting an image, for example ibr_001.tiff. Press the Enter key, or click on the
OK button, or double-click on the file name. An image should appear.
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3.2.3 A look at the menus again

Notice that now the menus are a bit different. Have a look. For example, in the File
submenu, the Print and Close items are selectable. Try closing the image with the Close

item.

Then try loading the image again. Notice that the Open Image dialog is in the same state as
just before you loaded the image into imview. Load the same image again,

Then try typing . This gives you some information on the current image.

Try loading different kind of images. Imview understands Z-IMAGE, TIFF, GIF, PNM and
ICS images.

3.2.4 A systematic try of all the menu items

This is not the matter of this short tutorial. Look up the user manual to see what each menu

item does.

3.3 The mouse on the image

3.3.1 Pixel information

With an image loaded into imview, place the mouse anywhere on the image, and then press
and hold down the left button mouse. Then drag the mouse around. Notice that information
on the pixel just underneath the mouse pointer on the screen is made available to you.

Notice that when you first click the left mouse button, the information window appears at
the top or at the bottom of the image depending which way is furthest from the position of

the mouse.

3.3.2 Distance and angles

With an image loaded into imview, place the mouse anywhere on the image, hold down
the Control key, click and hold down the left mouse button, then drag the mouse around.
Notice that a line is being drawn on the image, and that corresponding distance and angular

measurements are made available.

3.3.3 Zoom with the mouse

With an image loaded into imview, place the mouse anywhere on the image, and then press
the middle button, then drag the mouse down and to the right. This defines at Region of
Interest (ROI). Then release the middle button.
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Notice that the ROI has the same aspect ratio as the main window. This is called a constrained
zoom. Notice that the main window does not need to be resized when doing this sort of zoom,
and that therefore the zoom is fast.

Now on the zoomed image, click with the right button mouse. This is the Unzoom mouse
button.

Now hold the Shift key down, press the middle mouse button and then drag the mouse down
and to the right. Notice that this time the ROI is not constrained to the aspect ratio of the
main window. Release the middle button. This is called an unconstrained zoom. Notice that

this time the main window needs to be redrawn and is a bit slower.

Click with the right button mouse to unzoom.

3.3.4 Profiles

Press or select the Image->1-D profile menu item. The Display Profile dialog
appears. Now try to obtain some distance and angular measurement on the image just like
in section [3.3:2] That is, hold down the Control key, press and hold the left mouse button
and drag the mouse around.

The grey-level profile under the line defined in this way is shown

3.3.5 Points
To define “geom” points, hold down the Shift key and click on the image with the left mouse
button. Geom points can be deleted via the menus or with .

To define a “break”, hold down the Shift key and click on the image with the right mouse
button. The breaks can also be deleted.

Point can be saved in files (pointfiles). Pointfiles can be read in, etc.
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3.3.6 Colourmaps

3.3.7 Contrast/Gamma
3.3.8 Histogram

3.3.9 Printing

3.3.10 Saving
3.4 The command line

Type imview -h for help on the Unix command line.

3.5 Interaction with Z-IMAGE

Attach imview like any normal Z-IMAGE function. Type imview() for help on the available

command line arguments.

3.5.1 Useful tricks
3.5.1.1 Many images on the command line

Try imview(imagel, image?2,...)

Switch between them with <spacebar>‘ and ’Shift+<spacebar> . Try this while zoomed

n.

3.5.1.2 Parameter search

Press to reload a modified image.
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Chapter 4

User manual

This chapter describes the user interface to imview.

4.1 Conventions

Documenting software usage can be a bit difficult. In the following sections, some conventions

on typography and names are used.

4.1.1 Typed text

In order to help the reader a little bit with visual cues, the following textual conventions are
used:

Text that can be typed or viewed at the console appears in fixed-width font 1ike so.

Long stretches of such text, such as example output produced by the program appear in
framed centered boxes.

Menu shortcuts appear in fixed-width font with around them.

4.1.2 Menus and menu items

Figures of menus and menu items will be shown whenever possible. Menus and menu items
will always be shown in fixed-font when described in the text, and will sometimes be re-
ferred to with a text construction like this: Transform->Pointfiles->New pointfile. This
construction refers to the New pointfile menu item under the Pointfile submenu of the

Transform submenu of the main menu, as shown in Fig

31
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File Edit | Transform | image Help

5 >t -
Quick | Courmap ¥y rie.\,
Zoom >
Husues Talb] Poirtfite  w|| Open existing pointfile A
New pointfile Altep|
This is the online help for imview) Save currentpaim‘ﬁn‘e e+
Delete alf points Aft+D
. A Delete last point Altvd
Zooming with the moTse

Figure 4.1: This is the Transform->Pointfiles->New Pointfile menu item.

4.1.3 Mini-glossary

The following naming conventions are used:

4.1.3.1

Menu

Main menu The main menu of the application

Menu Any of the top-level items, itself a menu, of the main menu: File, etc.
Submenu Any of the items, itself a menu, of a menu or a submenu: Transform->Zoomn, etc
Item Any of the items, NOT a menu, of a menu or a submenu: File->0pen, etc
4.1.3.2 Mouse
Click Pressing and releasing a mouse button quickly.
Press Pressing one of the mouse buttons and keep it pressed.
Drag Pressing a mouse button and moving the mouse about with the button still pressed.
Release Releasing a mouse button.
4.1.3.3 Windows

Main window The window with the main menu on top, where images are displayed.

Dialog

A secondary window that is usually not present but pops up
as the result of some action.

Modal dialog A dialog that interrupts the flow of the application and that must be

4.1.3.4

attended to for the normal flow of the program to resume.

Subdividing the image

Imview supports a great variety of images. It is not limited to 2-D or grey-scale images or even

RGB images. The price of this absence of limitation is a relatively high degree of complexity.

One problem is to name unambiguously all the subsets of image data. Unfortunately there

isn’t a single non-ambiguous nomenclature concerning this topic. We will follow the following

conventions:
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e The size of an image along the x dimension is sometimes called the number of columns
of the image.

e The size of an image along the y dimension is sometimes called the number of rows of
the image.

e The size of an image along the z dimension is sometimes called the number of planes

of the image.

e Images come in image files. A single file can contain more than one individual image.
Such files are called multicomponent images, for want of a better expression. Com-
ponents in a multicomponent image need not have any relation to each other, although
normally they do.

e A multicomponent image made of images that are all of the same pixel type and of the
same dimensions, and such that each pixel location in each of the components correspond
to the same physical location, is called a multispectral image. For example an RGB
image is a multispectral image, and so is a Landsat or a SPOT image. Multispectral
images with more than a handfull of components will be called hyperspectral images,
such as for example the ARIES data.

e Each individual component in a multispectral image is called an image sample, for
example the G component of an RGB image.

e The succession of values along all samples in a multispectral image at a given location
on the image is called a spectrum.

In summary:

Number of columns size of the image in z

Number of rows size of the image in y
Number of planes size of the image in z
Image subset any part of an image. A single line or even

a pixel in any image is an image subset

Image component an element of an arbitrary multicomponent image that is still
an individual image, i.e: the G component of the lowest resolution
sub-image of a multiresolution Kodak photodisk image.

Image sample an individual component of a multispectral
image, i.e: the R component of an RGB image.

Image spectrum the succession of values along all samples in a multispectral image at a
given location.

Image frame a single multispectral image in a multicomponent image

i.e: a single RGB image in a movie is an image frame.
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It follows from this that an image composed of a single RGB component is a single-frame
image according to this definition. However, it is a multi-sample, or multispectral image, as

well as a multi-component image, of course.

In contrast, an image composed of a series of RGB images, for example the scanning of the
pages of a colour book, is a multi-frame image. Frames in a multi-frame image need not have
the same type or the same dimensions.
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4.2 Starting up

Starting up imview yields different results depending on whether it is started from the Unix
prompt or from the Z-IMAGE prompt.

4.2.1 The Unix prompt

At the Unix prompt, if the following text is typed:

% imview

then a “splash screen” appears which at the moment is a bit gaudy (Fig. 4.2)):

L imview.hin

File Edit Transform I|mage Help

Figure 4.2: Newfangled garish splash screen.

If the following text is typed:

% imview <animage> <anotherimage> ...

Then the first of these images in the argument list will show on screen (if it is in one of the
supported formats).

4.2.2 The Z-IMAGE prompt

At the Z-IMAGE prompt, if imview is typed, the usage is printed, as is the standard under
Z-IMAGE.
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Zimage-5.0.14 > imview
Purpose: displays images under X11
imview(<imagel>, [cmap:"std_grey"],<image2>, [cmap:"std_grey"],...

Usage :
, [CMAP:"std_grey"], [debug:"T/Y"]1)

etc ...

To actually display an image under Z-IMAGE, something along the line of:

Zimage-5.0.14 > files

myimage
Zimage-5.0.14 > imview(myimage)

must be typed. We can now proceed to the description of the menus and other features.
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4.3 The main menu

The imview main menu is a standard horizontal menu as found on most GUI applications

(see Fig. [4.3).

|f.¢'fe Edit ransform JImage Help |

Figure 4.3: Standard application menu.

Menu items can be pointed at with the mouse as usual. They can also be called with “short-
cuts”, which means holding the alt key and simultaneously pressing a letter. All the un-
derlined letters in the main menu indicate a shortcut for a submenu. For example
(holding the alt key and pressing the f key) invokes the File submenu.

After invoking a submenu, the whole menu can be navigated with the arrow keys. Typing
return on a menu item selects that item. Some items can be selected with shortcuts without
needing to go to a submenu and navigating them. A complete list of the shortcuts is given
in section and shortcuts are also indicated in the following explanatory sections.

4.3.1 The File submenu

This submenu can be invoked with the shortcut and deals with the reading and
writing of images.

Close Altic
Save Affrs
Print P
Quit  Aftrg

Figure 4.4: The file submenu.

The file submenu performs the following actions:

4.3.1.1 The Open item

Can be invoked with [alt+o].

Selecting this item causes the Open image dialog to be called up (see Fig .

Most of the controls on this dialog are relatively obvious. Use the left hand side buttons to
change the current directory. Clicking only once on a directory in the file list opens it in the
dialog. Double-clicking on a file opens it in imview, and so does single-clicking on it and then
clicking on the OK button. The Cancel button dismisses the dialog.

In addition, a path to an image can be typed by hand in the input section at the bottom of
the dialog. The input supports file name completion (with the tab key); the content of the
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[=] Open x|
Up one directory | |FLf
crni3sjpg
~/ Home crnias_smalljpg
/ Boot ibr_IDD}.jpg
imuiew,
SPWD/ patches/
-+ qt,i'
* allfiles
. Hidden files
*{ Directaries
[1 |

Figure 4.5: The Open Image dialog.

directory display will change after each keystroke when the path is typed, and a subset of the
Emacs control keys are supported:

e control+a to go back to the beginning of the line,

e control+e to go to the end of the line,

e control+f, or right arrow key to advance one character to the right,

e control+g, or left arrow key to go back one character to the left,

e control+k to kill the end of the line,

e control+w to kill the selection,

e control+_ one level undo,

e Tab to perform name completion,

e RETURN accept the seletion (same as clicking on the OK button),

e Esc dismiss the dialog (same as clicking on the Cancel button).

4.3.1.2 The Save item

Can be invoked with

This item is available only if an image is currently being displayed. If selected, the Save
Preferences modal dialog pops up (see Fig .

In this dialog, the diamond-shaped buttons are called ‘check buttons’. A check button is
selected if it appears pushed in and dark. It is deselected if it doesn’t appeared pushed and
is of a lighter colour. In Fig on the ‘Save image’ line, ‘Whole’ is selected while ‘Subset’

is not.
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o Save Preferences X

rize nane. RSERERE 5rouse..
Format: | TIFF — C‘mpression:

Save image: € ‘Whole {>Subset
Save what is: € ‘isible <>Underlying

Figure 4.6: The Save Preferences dialog.

The check buttons function in groups: only one of these buttons can be selected in a given
line at a given time. For example, on the ‘Save image’ line, if ‘Whole’ is pressed, ‘Subset’ gets
deselected if it had been selected before.Check buttons are used to express a choice between

limited alternatives.

The File name input field: The name of the output file can be typed in this field.
Pressing the ‘Browse’ button pops up a dialog nealy identical to the Open Image dialog for
selecting the output file interactively (see section |4.3.1.1)).

The Format choice menu:  Pressing this button-like menu pops up a short list of available
output formats. At present, imview can only save images in TIFF and Z-IMAGE formats.

The Compression choice menu: If this menu is greyed out, this means that the selected
output image format does not support compression. When available, this menu shows a list

of available compresssions for the selected format and the currently displayed image.
The Z-IMAGE format does not support compression.

The TIFF format supports the following compressions:

Compression name | Meaning Availability

None No compression For all images
LZW Lempel-Zif and Welch For all images
Packbits Packbits For all images
Group 3 CCITT Group 3 (fax) Binary images only
Group 4 CCITT Group 4 (fax) Binary images only
RLE Run-length encoding Binary images only
RLEW Wide Run-length encoding | Binary images only
Thunder Thunderscan Binary images only

The Save image check button group: This group allows the user to elect to save the
entire image being currently displayed, irrespective of zoom and pan (Whole button), or only
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the portion of the image currently being shown (Subset button).

The Save what is check button group: This group allows the user to elect to save the
image as it is interpreted on-screen (that is: as a binary or char 2-D image, with colourmap
applied to it, etc), by selecting the Visible button; or to save the underlying data by selecting
the Underlying button (that is: save the original CHAR, INT or DOUBLE image, without
colourmap present, possibly 3D, etc). Obviously for some images this doesn’t make any
difference.

The Cancel button: This button makes the dialog go away, no action are taken.

The Save button: This button causes the saving of the current image to be undertaken
with the preferences expressed by the user. If the saving is successful, the dialog is closed and
the user is returned to the main application. If an error occurs, an error dialog pops up and

the Save Preferences dialog stays up in order to let the user take corrective action.

4.3.1.3 The Close item

Can be invoked with

This item is available only if an image is currently being displayed. It will close the image
presently being displayed, and will delete it from the image list (see section . The next
image on the list will be displayed instead. If no images are left to be displayed, the splash
screen (see Fig|4.2)) is shown and this menu is disabled.

4.3.1.4 The Print item

Can be invoked with

This item is available only if an image is currently being displayed. If selected, the Print
Preferences modal dialog pops up (see Fig [4.7)).

See section [1.3.1.2] for a quick reminder of what ‘check buttons’ are.

The Print to check button group: One can either print to an actual printer or to a file.
If ‘Printer’ is selected, then the Print command input field is available. If ‘File’ is selected,
then the File name input field becomes available.

The Print command input field: Type in this field the command that is necessary to
print on the current system. Imview makes a reasonable guess based on the user’s environ-

ment. The result of the print process will be piped to this command.



4.3. The main menu 41

Frint Preferences

Figure 4.7: The Print Preferences dialog.

This input field is available only if the ‘Printer’ check button is selected. Otherwise this input
field appears in a lighter shade of grey and cannot be edited.

The File name input field: Type the output file name in this field. The ‘Browse’
button permits the user to specify an output file via a dialog nearly identical to the Open

Image dialog (see section 4.3.1.1)).

This input field is available only if the ‘File’ check button is selected. Otherwise this input
field appears in a lighter shade of grey and cannot be edited.

The Page title input field: A title for the printed page can be entered in this field.
It will be printed at the bottom of the page underneath the image. Only one line can be
entered. This input field will be unavailable if the ‘EPS’ check button is selected, because a
title cannot be attached to such an output format.

The Orientation check button group:  One can print either in portrait (upright page)
or landscape (page on the side) mode. The two check buttons correspond to these alternatives.

The Paper size check button group: Three paper sizes are supported: a4 (European
letter size), letter (U.S. letter size) and a3 (large European format).

The Language check button group: One can print in normal Postscript (PS) or in
Encapsulated Postscript (EPS) formats. The PS format is to make a simple, standalone
document. A title can be added to the bottom of the page (see above, the Page tile input
field). The EPS format is to create a document better suited to be included in other documents
(such as this documentation for example). No title can be attached to an EPS file, and they
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are not meant to be sent directly to a printer, although imview will not prevent the user from

doing so.

The Nb copies input field:  This field allows the user to specify the number of copies to
be sent to the printer. The content of this field is ignored for EPS files.

The I'mg: check button group: This group allows the user to decide whether to print
the whole image currently being displayed (irrespective of zoom, pan, etc), or to only print
the subset of the image that is currently shown on screen.

The Cancel button: Pressing this button will make the dialog go away without any action
taken. If the user selects the Print menu item again, the button selection, file name, title,

etc, will be remembered.

The Print button: Pressing this button will cause the user-chosen action to be under-
taken. If an error occurs, an error dialog will show up, and the Print preferences dialog
will stay around in order to let the user make corrective action. If no error occurs, the Print

preferences dialog will simply go away.

4.3.1.5 The Quit item

Can be invoked with

Selecting this item will quit the application. There is no warning or dialog asking for confir-

mation!

4.3.2 The Edit submenu

This submenu can be invoked with .

This menu is mostly disabled except for the preference submenu (see Fig .

idncke Ay
Fealy A
£ Aftey
Enpy A e
Fagie A ey
Efoar

Preferences »

Figure 4.8: The Edit menu.
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4.3.2.1 The Preferences submenu

Can be invoked with

A number of user preferences can be set with the help of the Preferences menu. At present,

there is no way to save the user preferences from session to session.

[ Smowth when umzooming |
I Show debug messages Alt+G
I Keep points when switching images Af+K
Change XOR value for fines...

Figure 4.9: The Preferences submenu.

Figure [4.9| shows the appearance of the Preferences submenu.

Smooth when zooming out (no shortcut)

By default, images displayed after zooming in and out are not smoothed for speed reasons.
Turning this option on by selecting the corresponding item causes zoomed out images to be
smoothed (using a bilinear interpolation). The result is much more pleasing to the eye but
takes about 3 times longer to display.

Show debug messages This item can be invoked with

Turning this option on will result in a large number of debugging messages to be printed.
Only for developers.

Keep points when switching images This item can be invoked with

Normally, points and lines (see section [4.10)) are deleted and saved to file when switching from
one image to the next in the image list (see section [4.3.4])). Turning this option on will result
in the points and lines defined in an image to be kept around when switching images. This

allows the user to compare points in two or more similar or related images.

Change XOR value for lines... For the record, this experimental feature allows the user
to change the appearance of overlay lines. One can safely ignore this.

4.3.3 The Transform submenu

This submenu can be invoked with

This submenu is itself made of three submenus (see Fig. 4.10)).
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Zoom »
Pointfife  »
Histogram »

Figure 4.10: The transform submenu.

4.3.3.1 The Colourmap submenu

There is no shortcut for this submenu.

Fig gives an example of a shortish colourmap submenu. This particular submenu is
dynamic in the sense that it will record the colourmaps associated with new images read via

the Open submenu (see section [4.3.1]).

Default Colourmap Aft+C
W std grey.fur
™ elassis.fut

Figure 4.11: The colourmap submenu.

The colourmaps on this menu are standard Z-IMAGE colourmaps and are searched for in
the present working directory, and in the directories indicated by the environment variables
$ZHOME/etc and $IMVIEWHOME. The $ZHOME environment variable is usually defined by Z-
IMAGE, so many colourmaps will appear automatically under this menu if imview is called
from this environment. $IMVIEWHOME can point to a variety of colon-separated locations, as
in:

’ IMVIEWHOME="/home/joe/colourmaps:/usr/local/Z-IMAGE/etc:$HOME/myluts"

Under Windows, IMVIEWHOME can also point to several location, but the separator is a comma,

not a colon (because of the drive name problem, as in C:\blabla.

All these locations are searched in order of appearance. Duplicate colourmaps will appear
duplicated in the list.

4.3.3.2 The Zoom submenu

There is no shortcut for this submenu.

The zoom submenu (see Fig4.12)) allows the user to zoom in or zoom out an image depending
on the item selected. There are a number of shortcuts corresponding to the functions available

via this submenu:

. zooms the image in by a factor of 100%,
. zooms the image in by a factor of 10%,
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. zooms the image out by a factor of 100%,

. zooms the image out by a factor of 10%

° sets the current zoom factor as the default,
° calls up a modal dialog to set the current zoom factor,
° calls up a modal dialog to set the default zoom factor,

° returns the current zoom factor to the default.

Zoom in 100% Alt+> |
Zoom in 10% Al

Zoom out 100% Aftt=
Zoom out 10% Aity,

Set this zoom factor as default At~
Sefect zoom factor... Aftrz
Select default zoom factor... AltrZ
Apply defauit zoom factor Aftrn

Figure 4.12: The zoom submenu.

Current and default zoom factors The current zoom factor is the one used to display
the image currently on screen. In most situation this is 1.0, unless the image is too small to
accomodate the main menu, or the user has specified a different factor for example on the
command line or with the currently described submenu.

The default zoom factor is the one the application reverts to by default: when switching
images, when clicking the right button of the mouse on the image or when typing the shortcut

[alt+n]

Both these values can be set to any strictly positive real number, however images must be

larger than some minimal dimension, discussed below.

Zoom submenu items The zoom submenu allows the user to do all sort of things with
the current and default zoom factors.

The first four items allow to zoom the image in and out by small and large increment. This
only affects the current zoom factor. The default zoom factor remains unchanged by these
operations.

In contrast, selecting the menu item Set this zoom factor as default does precisely this:
the current zoom factor becomes the new default.

The menu item Select zoom factor... calls up a modal dialog box where the current
zoom factor can be entered by hand, as shown in Fig. As described above, any strictly
positive real value is acceptable, but the real zoom factor will depend on the minimum image

dimensions, as described below.
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Enter zoom factor

|1.000000 |

LLv]

[ cancel || ok ]

Figure 4.13: The select zoom factor modal dialog.

The menu item Select default zoom factor.. calls up a nearly identical modal dialog
(see Fig. , but this time the default zoom factor can be entered by hand.

Enter default zoom factor

?
* ||1.000000 |

[ cancel || ok ]

Figure 4.14: The select default zoom factor modal dialog.

Selecting the menu item Apply default zoom factor applies the default zoom factor to the

current image.

Zoom factor and minimum image dimensions: Displayed images must have a mini-
mum width of 240 pixels to accomodate most of the main menu, and a minimum arbitrary
height of 10 pixels. The minimum zoom factor is computed for each image in order to achieve
these minimum dimensions. Users are not allowed to zoom out an image beyond this factor.
If an image is small enough in either dimensions, it might be displayed for the first time using
its minimum zoom factor which in this case is necessarily greater than 1.0. In this case, the
default zoom factor is the minimum zoom factor, and the user will only be able to zoom the

image in.

Zooming in and out can also be achieved efficiently with the mouse. See section[d.5for details.

4.3.3.3 The Pointfile submenu

Point files (also called “geom” files) are simple text files where statistics from manually selected
points in the image are recorded. These statistics can then be used in turn by other external
programs, for example to obtain pixelwise, spatial or angular measurements, extract sub-
images, etc. imview allows the creation and management of point files. Operations on points

and pointfiles are described in detail in section 4.10
Figure shows the Pointfile submenu.

The items on this submenu cause the following actions:

e Add point mode (shortcut ) If this item is activated (the square dot gets

filled with black on the left of the item), the mouse controls change to a different mode:
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T Add point mede g

Open existing peintfile o)

MNew poinifife Altrp

Save current pointfile  Aft+P

Delete all points Aft+D)

Delete last point Altrd

Figure 4.15: The Pointfile submenu.

the add point mode. In this mode, a left-click of the mouse on the image adds a point to
the pointfile, and a right-click of the mouse creates a ‘break’ (grouping of points). The
middle button can still be used for zooming, but in order to unzoom, the right button
cannot be used in this mode: the shortcut must be used instead.
When this mode gets deactivated (select the item again, and the square dot should
become empty), the mouse controls return to normal operations.
The quick, and often best way to activate the Add point mode is to hold down the shift
key. As long as the shift key is held down, mouse clicks on the image will behave the
same as in the Add point mode. l.e: shift-left click will add a point to the pointfile and
shift-right click will add a break.
Releasing the shift key deactivates the Add point mode.

e Open existing pointfile (shortcut ) calls an open dialog (same as in
section |4.3.1.1)), which allows the user to select an already existing pointfile. The points
defined in this files are read in, and displayed on the image. New points can be added
to it.

e New pointfile (shortcut ) calls an open dialog which allows the user to select
a new point file name. All new points will be saved to this file.

e Save current pointfile (shortcut [alt+P]) allows the user to save all the currently
defined points to the point file.

e Delete all points (shortcut ) will delete all the points currently defined on
the image.

e Delete last point (shortcut [alt+d]) will delete the last defined point.

4.3.3.4 The Histogram submenu

There are two planned items in this submenu, but only one is functional now: the
Contrast-brightness item (see Fig.

Selecting this item brings up the Edit transfer function panel, see section
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Contrast-Brightness  Aft+b]
futeraciioe Hweshoiling A

Figure 4.16: The Histogram submenu.

4.3.4 The Image submenu

This submenu can be invoked with . This submenu is dynamic in the sense that its
content varies depending on the characteristics of the image being displayed, as shown on

Fig

information... At}

Information... Aftrf 1-D profile... Aft+7

-0 profife.. Alty Show spectrim  AfLS

Next plane Al Mext sampie Aftr{|

Information... Aft+! FPrevieus plane  Aft+] Previeus sample Aft+}
i-Dprofife.. Alt+7 Select plane Aff+) Select sample Aft+f
Nexd image Aft+f Next image Aftrf Next image Aft+f
Previouws image Altik Previous image Altrk Previeus image  Altik
Image fist » Image fist > image list »

(a) (b) ()

Figure 4.17: The image submenu for a grey-level image (a), a 3-D image (b) and a multispec-

tral image (c).

4.3.4.1 Image information

The first item in this menu is the Information item. This item is always present in the menu.
Selecting this item brings up an information panel (Fig.

[=] Image information [X]

——— Image Information
Size: 386x450x1, 3 samples
Offsets: xO=0, yO=0, 20=0
Current zoom factar: 1.000000 Default zoom factor: 1.000000
Current subset: #=0 y=0 z=0 w=386 h=450
Frame: 1/1

Figure 4.18: The Image Information panel.

This panel allows the user to obtain some useful information on the image currently being
displayed.

4.3.4.2 1-D profiles

The second item, also always present in the menu, is the 1-D profile item When selected,
this item brings up the Display Profile panel (see Fig[4.19).
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Display Profile

Figure 4.19: The Display Profile panel for a grey-level image.

For anything interesting to be displayed on this panel, a profile must have been defined. This
can be done by holding down the Control button while dragging the mouse on the image.
The last profile defined in this way remains visible on the Display Profile panel.

See section [.§] for more informations on profiles.

4.3.4.3 Navigating the images

This submenu (see Fig a)) allows the user to view all the images present in the image list.
Each time an image is opened, either via the command line at startup or via the file menu (see
section 4.3.1)), it is recorded in the image list under the present submenu (see Fig b))

o
o

(a) (b)

Figure 4.20: The image submenu (a) and an example image list (b).

Some portions of this menu may or may not be available depending on the properties of the
image currently being displayed. The multispectral operations will not be available on a single
sample image, for example.

The items in this menu perform the following actions:

e Operations available for multispectral images: Single sample and 3-sample multispectral
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images are rendered respectively as grey-level images and RGB images. Multi-sample
images with 2 or more than 3 samples are rendered as a stack of 2-D grey-level images.
Each sample can be viewed separately. The following menu items allow to navigate in

the sample stack.

— Next sample (shortcut , or ) This item displays the next sample.

— Previous sample (shortcut |alt+}, or [End||) This item displays the previous
sample.

— Select sample (shortcut ) This item calls up a modal dialog allowing to
select a sample number for display, as shown on Fig. With the help of this

Enter desired sample number (0 <= n == 2)

-

[o |
| K. /-"|| Cancel |

Figure 4.21: The Select sample modal dialog.

modal dialog, the user can enter a sample number to be displayed. The range of
valid sample numbers is indicated in the message (in the example, between 0 and
3).

The window title shows, in between parentheses, the sample number currently
being displayed together with the tot